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About Dashboard Support Tools

Welcome to the Dashboard Support Guide. This guide describes the pages that you can use to evaluate your
custom dashboards.

It describes the Tools and Dashboard Support page, explains how to view information about the data model, and
shows you how to explore and publish the unit tests defined for module functions and queries. It contains
information about exploring type and property definition inconsistencies, shows you how to view help identifiers
per module, and explains where to find information on view usage in modules or sub-modules. Finally, it describes
the process of viewing the amounts of data persisted to the database per dashboard, explains the concepts of data
sources and their validation, and shows you how to review view error messages raised against one or more
modules.

The Tools and Dashboard Support page is your starting point when you want to evaluate the dashboards you build
for your monitored system. Use it to quickly assess the state of your dashboards and the underlying model, detect
potential problems early on, and prevent unexpected behavior in the application.

NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have
this role to access this dashboard.

* Getting Started

Getting Started

To access this dashboard, on the navigation panel, click Development Tools.

Figure 1. Development Tools page
Development Tools @ Thursday, September 29, 2016 1:30:53 PM - 2:30:53 PM 6D minutes w s Reports =

[5¢ Development Tools

@ Definitions Editor Script Agent Builder
v s, queries, functions and other artffacts that define your user < agents interact with the Foglight Agent Manager through the Foglight
i ble.

3|

8l

Data Browser
= w data model and inspact the objects and model that represents your Juery and s vice tool that allows testing of queries and scripts, and
environment.

Role Assignment

% Schema Browser
Data model bror d to explore existing t heir relationships, properties,
and data instany

le import to assign relevant and allowed roles to a list of views.

Module Validation
A Validation Tool which invokes some v
entity in the module including Errors a

Persistence Storage Usage
ser and site persistence mechanisms. View and manage

ations and displays the results for each
Warnings.

Definitions Statistics

Help Identifier
Lists all the Help Identifiers in a table.

i

ities in a dashboard containing the number of all
ividual module along with some additional

Types Documentation Report

g O o

Module Unit Test Report
Select one or more modules n
Reports defined for thi i

&

ee structure below, and run the Assodiated
nel on the right).

shboard and Report to test that Topology Types are properly

-

idation Tests to check that a root exists, root type has
s and at least one of the root pre s is not null.

Foglight 8.1.0 Dashboard Support Guide
About Dashboard Support Tools



The Development Tools page contains links to dashboards that you can use to verify different aspects of your
dashboards during the development cycle. For complete information, see the following chapters:

Definitions Editor: For more information, see the “Definitions Pane” section in the Foglight Web Component
Guide.

Data Browser: For more information, see the “Data and Data Sources Pages” section in the Foglight Web
Component Guide.

Schema Browser: For more information, see Exploring the Data Model on page 7.

Persistence Storage Usage: For more information, see Viewing and Managing Persistence Storage Usage
on page 26.

Help Identifier: For more information, see Finding Help Identifiers on page 19.
Module Unit Test Report: For more information, see Reporting on Module Unit Tests on page 12.

Script Agent Builder: For more information, see the “Building Script Agents” section in the Foglight
Administration and Configuration Guide.

Script Console: For more information, see the “Retrieving Data with Scripts and Queries” section in the
Foglight Administration and Configuration Guide.

Role Assignment: For more information, see the “Explore the Roles tab” section in the Foglight
Administration and Configuration Guide.

Module Validation: For more information, see Validating Modules on page 28.
Definitions Statistics: For more information, see Exploring Module Definitions on page 21.

Types Documentation Report: For more information, see Exploring Type and Property Definition
Inconsistencies on page 17.

Data Source Validation: For more information, see Validating Data Sources on page 31.
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Exploring the Data Model

Foglight® collects data from the monitored system and uses that data to dynamically build topology models at run-
time. A topology model organizes the data in a way that represents the logical and physical relationship between
items in your monitored environment and provides the context for the collected metrics.

Topology models consist of nodes, where each node is an instance of a topology object. The nature of the
monitored environment dictates the structure and complexity of each topology model and the collection of
available topology types. A basic server installation includes a set of core topology types, and each installed
cartridge adds to that collection.

Use the Schema Browser to view information about the available data types, their relationships in the data model,
properties, and object instances. This dashboard can help you better understand the data model structure.

i | NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have
this role to access this dashboard.

e Getting Started
e Drilling Down on Types

Getting Started

To access this dashboard, on the Development Tools page, click Schema Browser.

Figure 1. Schema Browser
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Drilling Down on Types

The Schema Browser allows you better understand the database schema. Start by selecting a namespace. A
namespace is a collection of types that share the same concept. For example, the Administration/Setup &
Support/Blackouts namespace contains a group of types that are used to implement blackouts in Foglight.
While type names must be unique within a namespace, it is possible to have same type names across multiple
namespaces.

Review the list of types associated with the namespace and drill down on a specific type to review its properties,
instances, and relationships with other types in the model.
To view a list of types associated with a namespace:
1 On the Development Tools page, click Schema Browser.
The Schema Browser dashboard appears in the display area.
2 Select a namespace.
In the Schema Browser dashboard, click the Select to Browse box.

Alist of nodes appears in the tree view, with each node representing a namespace.
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Common (Commor Type) te usaed by a client (whether ¢
(Common WCF Types)

Administration/Credentials{Credential Types (No Description)

Administration Tooling/Script Console (Mo Des ed-

Services{Builder (Mo Description)
Administration/Users & Security/Directory Services (Mo Description)
Dashboard Development,/Support/ Tools/Storage Reports (No Description))

Diagram (Diagram Component Types)

Foglight Units (Foglight Units)

Administration/Credentials/Resource Mapping (No

Dashboard Development,/Support/Unit Tests (A
4 | 1 | b

aining definitions

; | IMPORTANT: The type and collection of available namespaces depends on the range of
installed cartridges.

3 Expand a node in the list.

A list appears, showing the topology types associated with the selected namespace.
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Common (Mamespace) -
E3 Administration/Credentials/Credential Policies (Mo Description)) -
B3 Server Administration (Server Administration)

E3 Management Server/Commons (No Description)
B Monitoring (Monitoring DataSource)
TaskManager (TaskManager)
CatalystMetricHandler (CatalystMetricHandler)
ProblemTicket (ProblemTicket)
Date (Date)
DomainRoot (DomainRoot)
FSMBase (FSMBass)

HostStorage (HostStorage)
HostTopCPUProcessTrend {HestTopCPUProcessTrend)
Catalystl oadEstimator (CatalystloadEstimator)

AllTypelnstances (AllTypelnstances)

InferHoles (InferHoles

FglamClientInstance (FglamClientInstance)
PropertyRegExMergeFilter (PropertyRegExMergeFilter)
IncidentSystemEvent (IncidentSystemEvent)
HostExtension (HestExtension)

AlarmFilter (AlarmFilter)

ReportMetaData (ReportMetaData) -

4 Click a namespace node in the list.

The Schema Browser dashboard refreshes, showing a table containing the types associated with the
selected namespace. For each type, it shows its name, description, non-localized name, and the parent
type.

¥ schema Browser

Data model Schema Browser, used to explore existing Namespaces, Types, their relationships, properties, and data instances.

Recent Selections
Monitoring (Namespace)

IMonltor\ ng - <~ Select to Browse

Description Not enough information provided (Monitoring DataSource)

Id foglight-5
Types for Monitoring Namesapce
Search P - s
Name . Description Unlecalized Name Super Type
Abstract Abstract Abstract TypeAnnotation &
Bbstract Dependency Bbstract Dependency AbstractDependency Base Dependency
AbstractDependencylode AbstractDependencyNode AbstractDependencyNode DataObject
AbstractlogMessage AbstractLogMessage AbstractlogMessage DataObject
AccessInformation AccessInformation AccessInformation TopologyObject
Active Dependency Active Dependency ActiveDependency Abstract Dependency
2dminConfigTemplate AdminConfigTemplate AdminConfigTemplate TopologyObject
Agent Agent Agent TopologyObject
AgentHealthState AgentHealthState AgentHealthState Enumeration

5 In the Schema Browser dashboard, drill down on a type by clicking its entry in the table.

i | TIP: Another way to drill down on a type is to click a type entry in the Select to Browse list.

IMPORTANT: Selecting a generic type, for example, String, does not show any information about that
type in the Schema Browser. The Schema Browser only displays information about Foglight® types.

The Schema Browser dashboard refreshes, showing additional information about the selected type.
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[ZH Schema Browser

Data model Schema Browser, used to explore existing Namespaces, Types, their relationships, properties, and data instances.
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TIP: Drilling down on a type causes the Schema Browser to refresh and reflect information pertinent
to the type. To quickly return to the previous view, use the links in the Recent Selections area.

G+ Monday, June 20, 2011 11:35 AM - 3:36 PM 4 hours

and data instances.

Recent Selections
Monitoring (Namespacs)
String (Type)

saript Help (Typs)
Script Reference (Type)

Local Properties and Inherited Properties: Each table shows a list of properties that are local to
the selected type (Local Properties) or inherited from a parent type (Inherited Properties). For
each property, it indicates if the property is an identity property, and shows its name, description,
type name, and non-localized name. Identity properties are indicated with the = icon appearing on
the left of the property name.

Super Types: This tab shows a list of this type’s parent (ancestor) types.

Sub Types: This tab shows a list of this type’s child (descendant) types.

Super Types || Sub Types | Instances
=¥ Graph Sub Types
Fafgent

Clicking Graph Sub Types shows a graphical representation of the child type’s relationship with this
type.

T Dashboard Development » Schema Browser » Types Columns Layout

Ry

Agent F4Agent

C | TIP: Use the breadcrumb trail to return to the Schema Browser.

= Instances: This tab shows a list of this type’s instances.
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Super Types || Sub Types || Instances

Search o -

Mame «
July 19-WinSys

6 To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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Reporting on Module Unit Tests

The Module Unit Test Report lists the modules that exist in your environment. Each Foglight® module contains a
collection of operational elements such as views, dashboards, sub-modules, and other entities. For each module,
this dashboard shows the number of functions, queries, along with the numbers and percentages of unit tests
defined for the module’s functions and queries.

A unit test is a block of code that can be used to test the logic of a function or a query, to ensure it suits its purpose.
Unit tests can detect potential code problems early in the development cycle. The higher percentage of unit tests in
a module can prevent unexpected behavior in the application and, as such, improve its reliability.

Drill down on the unit test details to retrieve additional information about a module’s unit test. To publish
information about unit tests per module, run a report against one or selected modules using the reporting option
from the action panel.

i | NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have
this role to access this dashboard.

e Getting Started
e Exploring Module Unit Tests Result
* Publishing Module Unit Tests Result to a Report

Getting Started

To access this dashboard, on the Development Tools page, click Module Unit Test Report.

Figure 1. Module Unit Test Report

T Development Tooks » Module Unit Test Report &+ Sunday, October 9, 2016 1:43:10 PM - 2:43:10 PM 60 minutes [l Reports =
Module Unit Test Report
Select module(s) from the tree structure below and run the Associated Reports defined for this page (in the right page panel). &lso you can dick
"Details" in the unit tests column to run and display results and other details.
Search P~ F
Module Name « Total Functions Total Queries  Functions With UnitTests ~ Queries With UnitTests Unit Tests
#| Administration 102 0 0 (0%) 0 (0%) - |
Agent Adapter 0 0 0 (0%) 0 (0%)
Harms 37 22 0 (0%) 0 (0%)
Dependency Mapping 14 4 0 (0%%) 0 (0%%)
Development Tooks 0 0 0 (0%) 0 (0%)
Hosts 14 5 0 (0%) 0 (0%)
Infrastructure 2 0 0 (0%) 0 (0%) -
Log Menitor 13 4 1 (77%) 0 (0%) Details
Management Server 0 2 0 (0%) 0 (0%)
Reports 7 4 0 (0%) 0 (0%)
Canned Reports 3 ke 0 (0%) 0 (0%)
Editor 30 5 0 (0%) 0 (0%)
Services 0 3 0 (0%) 0 (0%)

Foglight 8.1.0 Dashboard Support Guide

Reporting on Module Unit Tests 12



Exploring Module Unit Tests Result

If a module includes function of query unit tests, you can drill down on the unit test details to see the unit test
details, whether they passed with success, or failed with errors. This information appears in the Module Unit Tests
Result view. Display this view by drilling down on Details in the Unit Tests column on the Module Unit Test Report
dashboard.

The Module Unit Tests Result view shows how many functions and queries exist in a module, the number of
function and query unit tests for that module, the unit test results, and whether unit tests are defined for all
functions and queries.

To return to the Module Unit Test Report, use the breadcrumb trail.

Figure 2. Returning to the Module Unit Test Report

% Development Tools » Module Unit Test Report » Module Unit Tests Result =+ Sunday, October 9, 2016 4:33:06 PM - 5:33:06 PM &0 minutes [l Reports
Module: Log Monitor
Total Functions: 13 4
Functions with Unit Tests: 1 Queries with Unit Tests: 0
All Function Unit Tests for Module Log Monitor -
Function Name Unit Test Name Duration (milliseconds) Result State =
Alarm Title Test an Alarm with No Rule ID 252 (@ Passed -
Test an Alarm with Rule ID 89 @ Passed
All Gruery Unit Tests for Module Log Monitor -
Query Name « Unit Test Name Duration {miliseconds) Result State =
No Unit Test has defined.
£ 12 Function{s) Missing Unit Test on Medule "Log Monitor" £ 4 Query(s) Missing Unit Test on Module "Log Monitor”
Function Name = || Query Name =
Populate Log File Directories F Hosts with Log Records -
Find LogeMonitorFileTrend By Host and File Name File Groups Per Host
Meszags Map Outstanding Alarms For Severity
Find LogMonitorRecords By Log File Files Per Host
Get Display Name
larm Diescrintinn

If any unit tests result in errors, this is indicated in the Result State column. Clicking this column shows additional
information about the error.

To display module unit test result:
1 On the Development Tools page, click Module Unit Test Report.
The Module Unit Test Report dashboard appears in the display area.
2 Observe the tree view of modules and the available unit tests per module.

3 Locate a node in the navigation tree by expanding its nodes to navigate to the module that includes unit
tests.

4 In the Unit Tests column, click Details.

5 The display area refreshes, showing the Module Unit Tests Result view.

Foglight 8.1.0 Dashboard Support Guide 13
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% Development Tools » Module Unit Test Report » Module Unit Tests Result ©+ Sunday, Octobar 9, 2016 4:33:06 PM - 5:33:06 PM 60 minutes [l Reports =

Module: Log Monitor

Total Functions: 13 Total Queries: 4
Functions with Unit Tests: 1 Queries with Unit Tests: 0

All Function Unit Tests for Module Log Monitor

3

Function Name Unit Test Name Duration (miliseconds) Result State: )
Alarm Title Test an Alarm with No Rule ID 252 (§ Passed -
Test an Alarm with Rule ID 82 @ Passed
All Gruery Unit Tests for Module Log Monitor -
Query Name Unit Test Name Duration {milliseconds) Result State =

Mo Unit Test has defined.

£ 12 Function{s) Missing Unit Test on Module "Log Monitor" £ 4 Query(s) Missing Unit Test on Module "Log Monitor”

Function Name 3 || Query Name =
Populate Log File Directories F Hosts with Log Records =
Find LogeMonitorFileTrend By Host and File Name File Groups Per Host

Meszags Map Qutstanding Alarms For Ssverity

Find LogMonitorRecords By Log File Files Per Host

Get Display Name

Alarm Nescrintion

6 Observe the Module Unit Tests Result view.

The view shows how many functions and queries exist in a module, the number of function and query unit
tests for that module, the unit test duration, results, and whether unit tests are defined for all functions and
queries.

7 If any unit tests result in errors, click the Result State column to inspect the error message.

The Error Details message box appears, showing the error details.

& emor Details x

javan.soript. ScriptException: com.quest.nitro.service.slinterfaces. scripting. ScriptingException:
com.quest.nitro.service.slinterfaces.scripting. ScriptAbortException: java.lang. IlegalfrgumentException: Type not found:
infrastructure: SeverityCounts

——-script start——

[ishouldn’t have errors.

—- script end —

at com.quest.nitro.webconscle.services. ScriptSenviceImpl.eval(ScriptSenviceImpl.java: 118)

at sun.reflect.GeneratedMethod Accessor333.invokeUnknown Source)

at sun.reflect. DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl java: 25)

at java.lang.reflect. Method.invoke{Method.java:557)

at com.quest.wef.services.Registry$LazyInvocationHandler.invoke{Registry. java: 127)

at $Proxy18%.eval{Unknown Source)

at com.quest.wef.core.module.test, Functions, run{Functions. java: 272)

at com.quest.wef.core.module.test, Functions, run{Functions. java: 181)

at com.quest.wef.core.module.test. Functions, run{Functions. java: 128)

at com.quest.wef,core.module.test, Functions. run{Functions. java: 78)

at sun.reflect iMethodAccessorl 168.invoke{Unk Source)

at sun.reflect. DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl java: 25)

at java.lang.reflect. Method.invoke{Method. java:557)

at com.quest.wef.core.module.function.FunctionManager.evaluatelavaFunction(FunctionManager.java: 295)
at com.quest.wef.core.module.function.FunctionManager.evaluate(FunctionManager. java: 258)

at com.quest.wef.core.module. function.FunctionManager.getResult{FunctionManager. java: 182)

at com.quest.wef.core.module. function.FunctionManager.getResult{FunctionManager.java: 133)

at com.quest.wef.core.module.function.BaseCodeHelper.invokeFunctionIntermal{BaseCodeHelper. java: 200)
at com.quest.wef.core.module.function. TimeRangeCodeHelper.invokeFunction( TimeRangeCodeHelper. java: 54)
at sun.reflect.GeneratedMethod Accessord5 Linvoke{Unknown Source)

at sun.reflect. DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl java: 25)

at java.lang.reflect. Method.invoke{Method. java:557)

at org.codehaus,groovy. runtime. callsite. PojoMetaMethodSitet PojoCachedMethodSite. invoke( PojoMetaMethodSite java: 188)
at org.codehaus,groovy. runtime. callsite. Pojol hodsite.call(Poj hodSite. java:52)

8 To return to the Module Unit Test Report dashboard, use the breadcrumb trail in the display area.

9 To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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Publishing Module Unit Tests Result to
a Report

Fogligh’[® comes with report templates that you can use to publish module unit tests result to a report. Depending
on the level of information that you want to see in the report, you can report on all modules, or selected modules

only.

Reporting on all modules results in a flat list of all modules and sub-modules showing the same information that
appears on the Module Unit Test Report. For each module and sub-module, it shows the number of functions,
queries, along with the numbers and percentages of function and query unit tests.

Reporting on selected module shows more details about unit tests. For example, you can see the numbers of all
functions and queries compared to the numbers of the module’s functions and queries that include unit tests. For
each unit test, you can see its name, duration, and result, and a list of functions or queries that are missing unit
tests. Use this information as a quick reference to investigate unit test results and to identify which components are
missing unit tests.

To publish module unit tests to a report:

1

On the Development Tools page, click Module Unit Test Report.

The Module Unit Test Report dashboard appears in the display area.
Observe the tree view of modules and the available unit tests per module.
To drill down on a module’s sub-modules, expand the module node.

For each module that contains unit tests, you can see the numbers of functions, queries, and the
associated unit tests.

Publish unit test results to a report.

a To create a report that displays unit test results for specific modules only, select those modules in
the list.

b In the top-right corner of the display area, click Reports.

A dwell appears.

fp Unit Tests (All Modules)

fp Unit Tests (Selactad Modules)
@) Crest= a New Repont

{p Run a Report

Eﬁ Manags Reports

i | TIP: Another way to access this dwell is through the action panel. On the General tab, under

Other Actions, click Create report.

¢ To report on all modules, in the dwell, click Unit Tests (All Modules).

d To report on the modules selected in Step a, click Unit Tests (Selected Modules).

; | TIP: Reporting on module unit tests takes the list of selected modules as input. When

reporting on selected modules, it is possible to edit that list to add or remove modules, as
required.

The Schedule Report dialog box appears.
e Complete the flow to schedule the report.

The newly generated reports can be accessed from the Reports dashboard. For more information
about reports, see the Foglight User Help or click the Help button in the dialog box.

5 To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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4

Exploring Type and Property
Definition Inconsistencies

The Types Documentation Report lists all namespaces that exist in your environment. A namespace is a collection

of types that share the same concept. For example, each Foglight® module has a collection of types associated
with it. While type names must be unique within a namespace, it is possible to have same type names across
multiple namespaces. For each namespace, the list shows the types it contains and their properties, and whether
their names follow the standard naming convention, and indicates if they include descriptions and enumeration
descriptions (for Enum types) that are identical to their names.

Use this dashboard to quickly evaluate if your model includes any types or properties with inconsistences in their
name and description and to list them. Start by selecting a namespace that includes errors. Then, review the types
that contain name or definition errors. For each type or property, the table shows its name, the number of
properties with errors (types only), whether the first letter is an uppercase letter, the type name is a compound
word with each element’s initial letter capitalized, and if the description (and enumeration description for Enum
types) exists or is the same as the type name.

i | NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have

this role to access this dashboard.

e Getting Started

Getting Started

To access this dashboard, on the Development Tools page, click Types Documentation Report.
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Figure 1. Types Documentation Report

T Development Tooks > Types Documentation Report @ Mandsy, October 10, 2016 B:26:07 AM - 9:26:07 AM 60 minutes » | [ Reports »
Types Documentation Report
Unit Tests dashboard with associated reports to test that Topology Types are properly documented,
Search 2 ~| s ||Failed Types for Monitoring Namespace -
Namespace Types with Error v {‘,’pti Search £~ =
— | Properties
503 e— 50
oo =t = Types with Errors with Errors E'”St Lrec;t;’ N‘EC;"G'
Server Administration 155 we— 177 - pper
154 e— 176 @  PowerVMServer 126 & (%] -
10 e— 20 PoweryVMHostEthernetAdapterPhysicalPort 117 @
Management Server/Servers/Data Management/Instances 13 e— 13 PovieryMyirtualCenter 110 (] a
Common 13m 75 CatalystGenericService 104 (7] [x)
Meta Data 2 m 5 PoweryMVIOS w & Q
ules/Manage Schedules 8 — 7 Sun_Host 101 ) o
7 — 3 10 ] I}
7m 8 w )
5 m— 9 100 (7] [x)
Reports S — 4 - o @ ©
Foglight Units pry— 10 Windows_Host w  § Q
Infrastructure, 3 e— 4 “ - - =
Administration 2 e— 4
Failed Properties for PowerVMServer Type N
3 — 5
try Variables 2 - 6 Search Pl =
2 m— 5 : N First Letter  Not Camel .
- Property Name Uppercase Case Description
— 3| || aggregatenlarmids o ) Q -

To explore type and property definition inconsistencies:

1

On the Development Tools page, click Types Documentation Report.
The Types Documentation Report dashboard appears in the display area.
Observe the list of namespaces on the left.

For each namespace, the table shows the number of types with errors, and the total number of types.
Click a namespace in the table.

The Failed Types and Failed Properties views on the right refresh, showing the selected namespace
types and properties with errors.

In the Failed Types view, observe the type errors.

For each type, the table shows its name, the number of properties with errors, whether the first letter is an
uppercase letter, the type name is a compound word with each element’s initial letter capitalized, and if the
description (or enumeration description for Enum types) exists or is the same as the type name.

In the Failed Types view, click a type.

The Failed Properties view refreshes.

In the Failed Properties view, observe the property errors.

For each property, the table shows its name, whether the first letter is an uppercase letter, the type name is

a compound word with each element’s initial letter capitalized, and if the description exists or is the same
as the type name.

To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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Finding Help Identifiers

The Help Identifiers dashboard allows you to list help identifiers for a selected module or sub-module. Help
identifiers can be embedded in help files to enable context-sensitive help for a specific component in the browser
interface.

Start by selecting a module. For each help identifier, the list shows the related component name, its help ID, and
the component purpose.

NOTE:

NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have
this role to access this dashboard.

e Getting Started

Getting Started

To access this dashboard, on the Development Tools page, click Help Identifiers.
Figure 1. Help Identifiers

% Development Tools * Help Identifiers & Monday, October 10, 2016 8:29:55 AM - 9:29:55 AM 60 minutes [l Reports

[ ] Help Identifiers

Lists all the Help Identifiers for the views in the selected Medule.

IAdminiStratiDn - <— Select a Module
WCF Module Version 3-027
Search B-lErc
Name « Help Id Purposes

(depracated)Dashboard Header n:administration.138 page, pagelet
Admin Dashboard Description n:administration.136 page, pagelet
Administration n:administration.22 homepags, pags
Administration 56 administraticn.administrationHome page
Admin Operations Toolbar n:administration.38 page, pagelet
Agents - Dwell n:administration.54 page, pagelet
Agents Dwell Information Table n:administration.55 page, pagelet
Configure - Dwell view|system:administration.52 page, pagelet
Configure Dwell Information Table view|system:administration.53 page, pagelet

To list help identifiers associated with a module:
1 On the Development Tools page, click Help Identifiers.
The Help Identifiers dashboard appears in the display area.
2 On the Help Identifiers dashboard, select a module.

The list of help identifiers refreshes, showing the help identifiers that are associated with the selected
module.

3 Observe the list of help identifiers.
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For each help identifier, the list shows the related component name, its help ID, and the component
purpose.

4 To return to the Development Tools page, click Development Tools in the breadcrumb trail.

Foglight 8.1.0 Dashboard Support Guide
Finding Help Identifiers



6

Exploring Module Definitions

Web Component Framework (WCF) definitions such as views and queries in Foglight® are organized into modules
and sub-modules. A module is a collection of related WCF definitions. Each module in Foglight contains a
collection of operational elements such as views, dashboards, sub-modules, and other entities. The Definitions
Statistics dashboard gives a quick overview of how views are used in individual modules or sub-modules. It also
shows the relationship of components such as views or associations with other components.

NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have
this role to access this dashboard.

e Getting Started
» Exploring Component Dependencies and Usage

* Viewing Module Definition Statistics

Getting Started

To access this dashboard, on the Development Tools page, click Definitions Statistics. From there, start by
selecting one or more modules in the Module Selector on the navigation panel.

Figure 1. Definitions Statistics

t Developmant Tooks » Definitions Statistics G+ Monday, October 10, 2016 5:32:4% AM - 9:32:43 AM 60 minutss = [ Reports =

Definitions Statistics

Provides a list of dependencies and usages for selected entity in the selected medules also displays the statistics of the system view's entities with the
number of all "Pages” and "Reports” on each individual medule and other purposes.

Dependencies & Usages | Statistics

Views r
Search L=
Wiew Module & Qualified ID
Activity Heading Administration system:administration.activityHeading -
Activity Links - Administer Administration system:administration.activityLinksAdminister
Activity Links - Agents Administration system:administration.activityLinksAgents
Activity Links - Investigate Administration system:administration.activityLinksInvestigate <
Dependencies for Activity Heading Usages for Activity Heading
Search 0o~ Search £~
Name & Name &«
system:administration.activityHeader - system:administration.administrationMew

system:core_commeons.62
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Exploring Component Dependencies
and Usage

WCF definitions can contain nested WCF definitions. For example, a dashboard can contain a several layers of
nested views. Container views depend on nested views to retrieve or display information provided by the nested
views. In that sense, container views use nested components. Exploring these relationships can help you better
understand the overall design of the browser interface, improve the efficiency of your development cycles by
creating reusable building blocks, and simplify the collection of dashboard artifacts by removing obsolete
components that are no longer needed or referenced.

The Dependencies & Usages tab on the Definition Statistics dashboard helps you explore the relationships
between the components in the selected module.

Figure 2. Dependencies & Usages tab on the Definition Statistics dashboard

= Bookmarks T Development Tooks > Definitions Statistics G Monday, October 10, 2016 8:32:43 AM - 9:32:49 AM 60 minvtes w | [ Reports
There are no bookmarks — e . .
= Homes - Definitions Statistics
fdn'irF,trator Provides 3 list of dependencies and usages for selected entity in the selected modules also displays the statistics of the system view's entities with the
::r;_tj number of all "Pages” and "Reports” on each individual module and other purposes.
Domains =
Hosts Dependencies & Usages | Statistics
Reports
Service Operations Conscle
Welcome L] v
¥ Dashboards hd Search L~ &
3 My Dashboards View Module a Qualified ID
N ir;n\r:stramr Activity Heading Administration system:administration.activityHeading -
Development Tools Activity Links - Administer Administration system:administration.activityLinksAdminister
" Infrastructure Activity Links - Agents Adrinistration stem:administration.activitylinksAgents
Log Monitor Activity Links - Investigate Administration system:administration.activitylinksInvestigate -
1 Management Server
Reports
a Services Dependencies for Activity Heading Usages for Activity Heading
3 Configuration
+ Module Selector Search Q- Search £~
Soardh P~ Name » Name ~
= system:administration actiityHeader = || system:administration.administrationhew
3 (#) Administration -
system:core_commons.62
d \w| Agent Adapter

Another way to view these relationships is by using the Design tab of the action panel. However, while the
Definition Statistics dashboard shows only the components that are related to the selected component and defined
in a selected module, the Design tab shows the related components regardless of the module in which they are
defined.

Figure 3. Design tab on the action panel

General | Design | Help
Name Type -
2 Management Server Configuration = Grid Layout I
[zl Mode Standalone = Property Viewer Rows Layout L
= children 0 Federation Information Table Cell-Griented Table |
HA Information Table Cell-Oriented Table
Product Row-Oriented Table |
Federation Row-Oriented Table
Database Row-Oriented Table
THARA n Nicionkad Tahl
Definition || Layout | Context

B Inspect

Module Administration b

Name Federation Information Table | |

Component Cell-Oriented Table

Purpose(s) Page, Pagelet

Comments

Context Inputs
Key Name Usage Data Type 52

1 [ | +
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To explore component dependencies and usage:
1 On the Development Toolspage, click Definitions Statistics.

The Definitions Statistics dashboard appears in the display area and the Module Selector appears on the
navigation panel.

2 On the navigation panel, expand a node in the Module Selector.

A list of sub-modules appears.

I Module Selector

#| Administration
#| Agents
Agent Adapters
Agent Managers
Agent Status
FglaM Support Bundle
#| Cartridges
Credentials
Data
Grouping
Home
Release Notes
Rules & Notifications
hedules
Setup & Support

g

il

A

Tooling
Users & Security
#| Agent Adapter

| IMPORTANT: The type and collection of available modules depend on the cartridges installed.

; | TIP: Selecting a sub-module in the tree allows you to narrow down the statistics for a specific set of
views in a module.

3 In the Module Selector, select one or more modules or sub-modules containing the components whose
dependencies and usages you want to explore. For example, to explore the views included in the Setup &
Support module, in the Module Selector, under Administration, select Setup & Support.

The Dependencies & Usages tab refreshes, showing the views that are defined in the selected module.

T Development Tocls » Definitions Statistics

[y Definitions Statistics

Provides a list of
number of all "P:

ctober 10, 2016 8:37:57 AM - 9:37:57]

s and usages for se d entity in the selected modules also displays the statistics of the systs
ports” on each individual medule and other purposes.

Dependencies & Usages || Statistics

Views v
Search
Wiew Module a Qualified ID

Agent Status Summary Agents system:administration_agents.21

Agent Status - View Agents system:administration_agents.16

Edit Agent Properties ninistration_agents.8

Edit Agent Properties (Ol) Agents n:administration_agents.54

Generic Progress Agents n:administration_agents.60

Properties Browser Frame Agents em:administration_agents.44

4 Drill down on a view to see its dependencies and usages. In the list of views, select a view.

For example, in the View column, scroll down and click Property Viewer.
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The Dependencies & Usages tab refreshes.

The Dependencies view shows one nested view. The Usages view indicates that the selected view is part
of other container views.

i | IMPORTANT: A selected view can include additional nested views and be part of other container
views that do are not listed here. That is because these views only list the components that are both
related to the selected component and defined in the selected module.

5 To return to the Development Tools page, click Development Tools in the breadcrumb trail.

Viewing Module Definition Statistics

A view can be a page, dashboard, home page, or have a combination of these purposes. For each module, the list
shows the numbers of views that are defined as pages, reports, dashboards, home pages, global actions, pages
(only), and the total number of views. The ratio of different view purposes in a module can reflect its complexity
given its number of home pages, dashboards, and reports. It can also give you an idea on the work required to
develop and maintain a module.

The Statistics tab on the Definition Statistics dashboard displays a summary of how views are used in individual
modules or sub-modules.

Figure 4. Statistics tab

Bookmarks

T Development Took » Definitions Statistics @ Monday, Dctober 10, 2016 8:37:57 AM - 9:37:57 AM 80 minutes v | [5] Repors
There are no bookmarks . e
-| [Ey Definitions Statistics
e Provides a list of dependencies and usages for selected entity in the selected modules also displays the statistics of the system view's entities with the
number of all "Pages” and "Reports” on each individual module and other purposes.
Dependencies & Usages || Statistics
Search b
) . Purposes Views . .
= Module Name Pages Reports Dashboards oo e Only Pages Views Functions  Queries
Total Counts 129 8 5 1 0 11 231 256 49
Blackouts 50 0 0 0 0 4 66 77 10
Administration 33 0 0 1 0 1 56 102
Environment 19 7 0 0 0 1 62 53 22
Agents 15 0 1 0 0 5 17 & 10
Setup & Support 7 0 4 0 0 0 9 3 4
Communication with Dell 4 0 0 0 0 0 17 12
Cartridges 1 1 0 0 0 0 4 1 3
= Agent Adapter 0 0 0 0 0 0 0

To see module definition statistics:
1 On the Development Tools page, click Definitions Statistics.

The Definitions Statistics dashboard appears in the display area and the Module Selector appears on the
navigation panel.

2 On the navigation panel, expand a node in the Module Selector.

A list of sub-modules appears.
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[~ Module Selector |
|Seard' L~ |
B [#] Administration

B [#] Agents
] Agent Adapters
|| Agent Managers
] Agent Status
] FglaM Support Bundle
|#| Cartridges
|| Credentials
[O) Data
[ Grouping
[ Home
] Release Motes
) Rules & Motifications
|| Schedules
[ Setup & Support
[l Tooling
] Users & Security
[l Agent Adapter

IMPORTANT: The type and collection of available modules depend on the range of
installed cartridges.

-o

TIP: Selecting a sub-module in the tree allows you to narrow down the statistics for a specific set of
views in a module.

-o

In the Module Selector, select all modules and sub-modules whose view definition statistics you want to
see.

The Definitions Statistics dashboard refreshes, showing the views defined in the selected modules.

+ Bookmarks

T Development Tooks * Definitions Statistics G+ Monday, October 10, 20|
There are no bockmarks = . L
» Homes v Definitions Statistics
» Dashboards A4 Provides a list of dependencies and usages for selected entity in the selected moedules also displays the

number of all "Pages” and "Reports” on each individual medule and other purposes.
+ Moedule Selector 8 = &

[ search 2] | Dependencies & Usages | Statistics

B v Administration &
[l Agents Purposes

Module Na P: Reports

[#| Cartridges . me FLE Ert Dashboards Home Pages Global Actions
Ed | Credentials Total Counts 34 1 0 1 0
B Data P Administration 33 0 0 1 0
(] Grouping ha, Cartridges 1 1 0 0 0
[0 Home Agent Adapter ] ] o ] o

|| Releass Notes
] Rules & Notifications
[0 Schedules

] Setup & Support
[ Tooling
[ Users & Security
|+ Agent Adapter
B Alarms

Observe the view definition statistics.

For each module, the Definitions Statistics dashboard shows the numbers of views that are defined as
pages, reports, dashboards, home pages, global actions, pages (only), and the total number of views.

To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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Viewing and Managing Persistence
Storage Usage

The Persistence Storage Usage dashboard allows you to view the amount of data persisted to the database for
each individual dashboard, and the size of these data blocks. For each data block, it shows its size and the date
and time it was last modified. You can delete these data blocks to restore the dashboards to their original state, as
required. Data blocks are stored in the database. Sorting them by size tells you which data blocks are utilizing
highest amounts of database resources which may affect the overall database performance, and delete them, as
required, to improve the database performance.

i | NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have

this role to access this dashboard.

e Getting Started

Getting Started

To access this dashboard, on the Development Tools page, click Persistence Storage Usage.

Figure 1. Persistence Storage Usage

%t Development Took * Page persistence table

Persistence Storage Usage

Storage details of the WCF user and site persistence mechanisms. View and manage page-level persistence blocks.

v, October 10, 2016 9:03:39 AM - 10:03:35 AM 60 minutes [l Reports -

Delete Search L-| 5
Name Size v Last Modified
states/system_administration_blackout_configuration.36.xmi 1.7KB 10/9/16 5:29 PM +
states/system_wcf_tools_definitions20statistics.3.xml 1.6 KB 10/10/16 9:57 AM
states/system_infrastructure. mainViewOf TheModule xml 1.5KB 10//5/16 5:23 PM

states/system_foglight.2.xml 1.1KB 10/5/16 5:29 PM
1.0 KB 10/9/16 5:29 PM

986 B 10/9(16 5:29 PM

777B 10/9/16 5:25 PM

748B 10/9/16 5:29 PM

700 B 10/9/16 5:29 PM

states/system_wcf_tools_module20validation.medulevalidation.xml 660 B 10/9/16 5:29 PM
s/system_oshost.storageDetailDashboard xml 655 B 10/5/16 5:23 FM
statesfsystem_core_commons.115.ml 656 B 10/9/16 5:29 FM

; | NOTE: The type and collection of data blocks depends on the range of installed cartridges.

To view and manage persistence storage usage:
1 On the Development Tools page, click Persistence Storage Usage.

The Persistence Storage Usage dashboard appears in the display area.
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Observe the view definition statistics.

For each data file, the Persistence Storage Usage dashboard shows its size and the date and time it was
last modified.

To delete one or more data files, select them in the table and click Delete.
The Confirm File(s) Delete dialog box appears.
To proceed, click Delete.

To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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Validating Modules

Each Foglight® module contains a collection of operational elements such as views, dashboards, sub-modules,
and other entities. Use the Module Validation dashboard to validate a module or sub-module and review the
related messages. For each selected module or sub-module, the list shows the total number of error, warning, and
information messages, and then the number of error, warning, and information messages for each entity in the
module. Drilling down on a message number shows the validation message in a separate dialog box. Use this
information to improve module definitions as you develop.

NOTE: If the Show deprecated definitions user preference setting is enabled, the numbers of
messages related to deprecated components appear as a separate number in the list, and are marked
Deprecated. To access the User Preferences, on the navigation panel, under Dashboards, select
Configuration > User Preferences. For complete information about configuring user preferences, see
the Foglight User Guide.

NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have
this role to access this dashboard.

e Getting Started

Getting Started

To access this dashboard, on the Development Tools page, click Module Validation. From there, start by
selecting one or more modules or sub-modules in the Module Selector on the navigation panel.

Figure 1. Module Validation

I Bookmarks
There are no bookmarks

S -| 8 Module Validation

Administration

t Development Tools > Module Validation Gr Monday, October 10, 2016 9:05:21 AM - 10:05:21 AM 60 minutes » | [&] Report

s Avalidation Tool which invokes some validations and displays the results for each entity in the module including Errors and Warnings.
Aarms -
e Search B~

Reports et - Tot,'a\ Messages ;
Service Operations Console Errors ‘Warnings Informations

Welcome Administration Q 39 91
b Dashboards vl Agents A 0 2

My Dashboards Development Tooks 0 0
Administration " a

Alarms:

Heo

Infrastructure

Log Monitor

Management Server

Reports Validation Details for Administration Module
Services

Search P~

Messages

Entity Type « Entity Name Errors Warnings Informations

Search 2
) Administration =
Agent Adapter
Alarms
Dependency Mapping

) Development Tools
foglight Current Statistics Text

=Expiry
Renderer LicenseExpiry30

Currently Licensed Capabilities Text

Hests License Information Text

Infrastructure Administration
Log Monitor View Current Licensed Capabilities Information Table

o e mMooooooo

Management Server Currently Licensed Caabilities Information Table
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To validate a module:

1

On the Development Tools page, click Module Validation.
The Module Validation dashboard appears in the display area.
On the navigation panel, expand a node in the Module Selector.

A list of sub-modules appears.

™ Module Selector
Search >
| Administration
/| Agents
Agent Adapters
Agent Managers
Agent Status
FglaM Support Bundle
#| Cartridges
Credentials
Data
Grouping
Home
Release Motes
Rules & Notifications

schedules
Setup & Support
Tooling

Users & Security

#| Agent Adapter

i | IMPORTANT: The type and collection of available modules depend on the range of installed
cartridges.

TIP: Selecting a sub-module in the tree allows you to narrow down the statistics for a specific set of
views in a module.

In the Module Selector, select all modules and sub-modules that you want to validate.

The Module Validation dashboard refreshes, showing the views defined in the selected modules.

[ ETEEI % D= sols » Module Validation Co M Yetober 10, 2016 60 minutes 3] Repons
There are no bookmarks i i
. Module Validation
A Validation Teol which invekes scme validations and displays the results for 2ach entity in the medule including Errors and Warnings.
Search P ]
. Total Messages
(rirze ST Errors Warnings Informations
Administration [%) 39 91 o+
Ala [x] 25 53 0
Development Tools (-] 0 0
Search
(¥ Administration
Agent Adapter =
2 Validation Details for Administration Module -
¥ Mapping
¢ Development Took Search -] =
foglight Messages
Entity Type o Entity Na o
Hosts Y TYp ity Name Errors Warnings Informations
Infrastructure 0 1 =
Log Monitor g i

Observe the module validation statistics.

For each selected module or sub-module, the top table shows the validation state (Normal €, Warning ¢,
or Fatal @), and the number of error, warning, or informational messages associated with that component.

View detailed validation results for a specific module or sub-module.
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a Inthe top table, click a row containing a module or sub-module.

On the Module Validation dashboard, the Validation Details table refreshes, listing the individual
module entities against which one or more validation messages are generated.

% Development Tocls > Module Validation € Mond

@8 Module Validation

Module a Validation
Administration ]
Agents Mo
Alarms %]
DevelopmenhTools (<]
Validation Details for Agents Module
Entity Type + Entity Name

Agent Status - View
View
Agent Status Summary

AValidation Tool which invokes some validations and displays the results for each entity in the module including Errors and Warnings.

Search

Total Messages
Errors ‘Warnings

oW e @

g1
2

59

Search

Messages
Errors ‘Warnings

[4)
B

Informations

Informations

nutes v | [l Reports -

b Observe the Validation Details table.

For each entity, the table shows its type, name, and the numbers of error, warning, and

informational messages.

¢ Review an entity’s error, warning, or informational messages by clicking the related columns.

A dialog box appears, listing the messages of the selected type that are associated with the entity.

@ Error Messages

because it is deprecated or not public

Validation Messages for Manage Rules & Notifications Dwell Information Table (View)

The view "Manage Registry Variables” may not be referenced in the Flow because it is deprecated or not public

The "MNext page" Flow type using View "Manage Registry Variables” is invalid because the View is not of purpose
"Dashboard™ nor "Page” or its required Context Inputs are not satisfied by this Definition or the View may not be referenced

X

d Use this information to improve module definitions as you develop.

6 To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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Validating Data Sources

A data source contains information that is displayed in Foglight®. This information is stored in data objects as
object properties. A data source encapsulates all the system knows about the collected data. It is organized as a
dynamic graph of object types, starting from a root that represents the entire data model. The Data Source
Validation dashboard allows you to select a data source and check if that data source has a root, and that the root
type has properties defined. Detecting and solving data source problems early on can prevent problems in the
browser interface. If any errors are found on the data source, they appear in the list. For each error, the list shows
its type and the error description. The overall data source validation result also appears on the dashboard. Use
this information to improve data source definitions as you develop. Warning messages usually appear for
information purposes only, to indicate a non-fatal conditions. Unlike fatal messages, they do not prevent the data
source from being validated.

NOTE: The Cartridge Developer role grants access to this dashboard. Your Foglight account must have this
role to access this dashboard.

e Getting Started

Getting Started

To access this dashboard, on the Development Tools page, click Data Source Validation.

Figure 1. Data Source Validation

% Development Tools » Datasource Validation Results Oct 10, 2016 10:16:45 AM CST [l Reports

Data Source Validation

A series of Data Source Validation Tests to check that a root exists, root type has properties and at least one of the root properties is not null.
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error . metric: DataObject of type ‘foglight-5:Metric’ for datasource: foglight-5:foglight-5":/anonymous/:

8300d0-3fa2-491a-b33d-6aa42ccf0872Data0bject retur
error | dataObject with uniqueld: fancnymous/86fd8bat-0100-4e77-a21a-f50256a7e62e of type: foglight-5:Metric marked as reloablable however after it was rel
error metric: DataObject of type foglight-5:Metric’ for datasource: Yoglight-5:foglight-5': fanonymous/86fd8bas-0100-4e77-a2 1a-f502 56a7e6 2e DataObject retu
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To validate a data source:
1 On the Development Tools page, click Data Source Validation.
The Data Source Validation dashboard appears in the display area.
2 On the Data Source Validation dashboard, select a data source.

If any validation errors exist for the selected data source, they appear in the list.
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3 Observe the list of data source validation errors.

For each help identifier, the table shows its type and description. The overall validation result also appears
just above the table. You can use this information to improve data source definitions, as required.

4 To return to the Development Tools page, click Development Tools in the breadcrumb trail.
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About Us

We are more than just a name

We are on a quest to make your information technology work harder for you. That is why we build community-
driven software solutions that help you spend less time on IT administration and more time on business innovation.
We help you modernize your data center, get you to the cloud quicker and provide the expertise, security and
accessibility you need to grow your data-driven business. Combined with Quest’s invitation to the global
community to be a part of its innovation, and our firm commitment to ensuring customer satisfaction, we continue
to deliver solutions that have a real impact on our customers today and leave a legacy we are proud of. We are
challenging the status quo by transforming into a new software company. And as your partner, we work tirelessly to
make sure your information technology is designed for you and by you. This is our mission, and we are in this
together. Welcome to a new Quest. You are invited to Join the Innovation™.

Our brand, our vision. Together.

Our logo reflects our story: innovation, community and support. An important part of this story begins with the letter
Q. It is a perfect circle, representing our commitment to technological precision and strength. The space in the Q
itself symbolizes our need to add the missing piece—you—to the community, to the new Quest.

Contacting Quest

For sales or other inquiries, visit https://www.quest.com/company/contact-us.aspx or call +1-949-754-8000.

Technical support resources

Technical support is available to Quest customers with a valid maintenance contract and customers who have trial
versions. You can access the Quest Support Portal at https://support.quest.com.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. The Support Portal enables you to:

* Submit and manage a Service Request.

* View Knowledge Base articles.

¢ Sign up for product notifications.

* Download software and technical documentation.
* View how-to-videos.

* Engage in community discussions.

e Chat with support engineers online.

* View services to assist you with your product.
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